
WAAS RAIM/FDE PREDICTION PROGRAM INSTRUCTIONS

 NOTE:  The WFDE Prediction Program is part of the Garmin Trainer and Route Planning software programs.  The 
required software and instructions are available via the Garmin website at www.garmin.com.

 NOTE:  The WFDE Prediction Program requires an internet connection to provide access to current almanac, GEO 
almanac, and confi guration fi les.

 NOTE:  These instructions assume the user has experience operating the G1000 with GIA 63W, the GNS480/CNX80, 
or the applicable GNS 400W/500W Series Unit and is familiar with the operation of RAIM and FDE.
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1 OVERVIEW

1.1 FAULT DETECTION AND EXCLUSION (FDE)
The GARMIN G1000 with GIA 63W, the GNS480/CNX80, and the GNS 400W/500W Series products incorporate 

Fault Detection and Exclusion (FDE) features, satisfying the requirements of TSO-C145a/C146a and “GPS Oceanic/Remote 
Navigation” per FAA AC 20-138A Appendix 1.

FDE consists of two distinct parts: fault detection and fault exclusion.  Fault detection (RAIM) detects the presence of an 
unacceptably large pseudorange error (and presumably, position error) for a given mode of fl ight or a satellite failure which 
can affect navigation.  Fault detection is synonymous with RAIM (Receiver Autonomous Integrity Monitoring).  Upon the 
detection of a fault, fault exclusion follows and excludes the source of the unacceptably large pseudorange error, thereby 
allowing navigation to return to normal performance without an interruption in service.  FDE functionality is provided for 
oceanic, en route, terminal, and non-precision approach phases of fl ight.  The FDE functionality adheres to the missed alert 
probability, false alert probability, and failed exclusion probability specifi ed by TSO-C145a/C146a.

The WFDE Prediction Program allows the pilot to specify the planned departure date/time, route type, ground speed, 
ground speed variation, and maximum allowable outage.  When provided through NOTAM or other sources, GPS satellites 
with known failures can be excluded through the program's setup function.

 
NOTE:  WAAS is one of several systems generically known as SBAS (Space Based Augmentation System), Garmin 
WAAS certifi ed products are designed to work with any TSO-C145a/C146a compliant SBAS systerm.

The WFDE Prediction Program is designed for use with TSO-C145a/C146a approved WAAS-(Wide Area Augmentation 
System) certifi ed Garmin products.  These products include:

• GPS 400W, GNC 420W, GNC 420AW, GNS 430W, GNS 430AW
• GPS 500W, GPS 500W TAWS, GNS 530W, GNS 530W TAWS, GNS 530AW, GNS 530AW TAWS
• GNS 480, CNX80
• G1000 with GIA 63W

1.2 DETERMINING WHEN A WFDE PREDICTION IS REQUIRED

The WFDE Prediction Program determines whether the GPS constellation is robust enough to provide a navigation solution 
for the specifi ed route of fl ight.  As required (dependent upon type of fl ight plan, GPS SW version, and GPS antenna), prior 
to departure the operator must use the WFDE Prediction Program supplied with the applicable trainer or route planning 
software to demonstrate that there are no outages in the capability to navigate on the specifi ed route of fl ight (Table 1).

 
NOTE:  If the route of fl ight requires an alternate airport, multiple predictions may be required (one for the primary 
and one for the alternate) to verify RAIM and/or WAAS satellite availability at the primary and the alternate 
approach.

A WFDE Prediction is required for the following instances (see also Table 1):
• For Garmin WAAS enabled units with GPS Software v3.XX or earlier (regardless of GPS antenna model):  an FDE 

prediction is required for Oceanic/Remote operation where GPS is to be the primary source of navigation per FAA 
AC 20-138A Appendix 1.  The Oceanic/Remote fl ight phase occurs when the fl ight plan will place the aircraft more 
than 200 nautical miles from the nearest airport.  All operators using a Garmin WAAS-certifi ed unit as primary 
means of navigation in oceanic/remote areas under FAR parts 91, 121, 125, and 135 must utilize the WFDE 
Prediction Program prior to conducting a fl ight in these areas.
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• For Garmin WAAS enabled units with GPS Software v3.XX or earlier, and using an unapproved* GPS antenna: a 
RAIM prediction is required for all fl ight operations in accordance with the National Aviation Authority guidelines 
for TSO-C129a equipment.  Examples of such operations include navigation of U.S. Area Navigation (RNAV) routes, 
Standard Instrument Departures (SIDs), or Standard Terminal Arrival Routes (STARs) per FAA AC 90-100A “U.S. 
Terminal and En Route Area Navigation (RNAV) Operations”.

• For Garmin WAAS enabled units with GPS Software v3.XX or earlier, and using an unapproved* GPS antenna:  an 
operational limitation in the form of a WAAS satellite visibility prediction is required for all LNAV/VNAV or LPV 
approaches.

• For Garmin WAAS enabled units with GPS Software v2.XX or earlier (regardless of GPS antenna model):  an 
operational limitation in the form of a WAAS satellite visibility prediction is required for all LNAV/VNAV or LPV 
approaches.

A WFDE Prediction is not required for the following instances (see also Table 1):
• For Garmin WAAS enabled units with GPS Software v3.XX and using an approved* GPS antenna:  a RAIM 

prediction is not required.
• For Garmin WAAS enabled units with GPS Software v3.XX and using an approved* GPS antenna:  a WAAS satellite 

visibility prediction is not required for LNAV/VNAV or LPV approaches.

Route Type GPS SW Version Antenna Type* WFDE Prediction 
Required?

Oceanic/Remote 2.XX or earlier Approved/Unapproved YES
Enroute/Terminal 2.XX or earlier Approved/Unapproved YES
LNAV/VNAV or LPV Approach 2.XX or earlier Approved/Unapproved YES
Oceanic/Remote 3.XX Approved/Unapproved YES
Enroute/Terminal 3.XX Approved NO
Enroute/Terminal 3.XX Unapproved YES
LNAV/VNAV or LPV Approach 3.XX Approved NO
LNAV/VNAV or LPV Approach 3.XX Unapproved YES

Table 1

*Approved refers to antennas listed in the applicable Installation Manual (Table 2) that allow the Garmin WAAS enabled 
unit with GPS software v3.XX or later to meet the TSO-C145a/C146a requirements without requiring the operational 
limitations specifi ed in the applicable Installation Manual.  Unapproved refers to antennas listed in the applicable Installation 
Manual (Table 2) that allow the Garmin WAAS enabled unit (regardless of GPS Software version) to meet the TSO-C145a/
C146a requirements with the operational limitations specifi ed in the applicable Installation Manual.

Document Name Document Number
GIA 63/GIA 63W Installation Manual 190-00303-05
400W Series Installation Manual 190-00356-02
500W Series Installation Manual 190-00357-02
GNS 480 (CNX80) Installation Manual 560-0982-01

Table 2
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2 IDENTIFYING GPS SOFTWARE VERSION
The GPS software version used in the Garmin WAAS enabled unit must be determined prior to performing the FDE 

prediction. The GPS SW version may be a factor in determining if a WFDE prediction is required.

2.1 GNS 400W/500W SERIES PRODUCTS
Identifying GPS Software Version of a GNS 400W/500W Series product:

1. Turn the COM power/volume knob clockwise to turn the unit on.

2. The Main and GPS software version page (Figure 1) appears briefl y, take note of the GPS SW Version.

Figure 1  GPS SW Version Page

2.2 GNS 480/CNX80
Identifying GPS Software Version of a GNS 480 or CNX80:

1. Push the PWR/VOL Knob to turn the unit on.

2. Press the FN Key and then the SYS Key to reach the System functions.

3. Press the VERS function smart key to display the Software Versions Page (Figure 2), note the GPS Engine 
Software Version.

Figure 2  Software Versions Page
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2.3 G1000 WITH GIA 63W

Identifying GPS Software Version of a G1000 with a GIA 63W :

1. With the G1000 in normal mode, use the FMS Knob on the MFD to select the AUX - System Status Page 
(Figure 3).

2. Note the GPS Software Version.

Figure 3  System Status Page

GPS Software Version
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3 RUNNING THE FDE PREDICTION PROGRAM
Trainer and route planning software for WAAS-certifi ed Garmin products include a WFDE Prediction Program to meet 

the FDE requirements for GPS as a primary means of navigation for Oceanic/Remote operations (reference FAA AC 20-138A 
Appendix 1).

To use the WFDE Prediction Program, begin by entering the intended fl ight plan into the applicable Garmin Trainer 
software or the Garmin Route Planning software.  The WFDE Prediction Program uses this information to analyze satellite 
coverage along the intended route of fl ight.

 NOTE:  A fl ight plan must be created and activated (using the applicable Trainer or Route Planning software) prior 
to running the WFDE Prediction Program.  The WFDE Prediction Program only works with the currently active fl ight 
plan.  Follow the  software instructions to create and activate a fl ight plan.  Software and instructions are available 
via the Garmin website at www.garmin.com.

Running the WFDE Prediction Program:

1) Make sure the applicable Trainer or Route Planning software is running .  If using a Trainer program, make sure 
the simulated unit is on, and the desired fl ight plan is active.

2) If using a Trainer program, select the ‘Options’ menu (Figure 4) in the upper left corner, and select ‘WFDE 
Prediction Program’ (G1000 Trainer), or ‘Fde Prediction Program’ (GNS 400W/500W Trainer).  OR

3) If using the Garmin Route Planning Software, click on the ‘Start Prediction’ button after setting up the route 
(Figure 4).

Click to Start
Prediction Program

Figure 4  Start Prediction Program Options

Program Name

 NOTE:  If the WFDE Prediction Program has not been used previously, or has not been run recently, a series of pop-
up messages (Figure 5) may precede the WFDE Prediction Program window.  Follow the on-screen instructions to 
download new data from the internet.  The download time is normally very short (nearly instantaneous), but may 
vary with internet connection.  See the ‘Updating/Changing the Almanac and Confi guration Files’ section of this 
document for details.
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Figure 5  Possible Update Messages

4) The WFDE Prediction Program window appears (Figure 6) listing the fl ight plan waypoints, selected antenna, and 
the current date/time as the departure time.  It is important to verify that the displayed route is correct before 
proceeding with the prediction.  Reference Table 3, and verify the correct Garmin part number (006-A0154-0X) 
appears at the top of the screen for the applicable product.  If the part number is incorrect, see Section 5 of this 
document.

Figure 6  WFDE Prediction Window

Garmin Part 
Number, 

Use to Verify 
Version of 
Program
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 NOTE:  The  ‘Other Garmin series’ listing in Table 3 should be selected when using a system with a TSO-C146A 
compliant WAAS antenna and software (see Section 1.2).

Garmin Part Number Applicable Product
006-A0154-01 G1000 with GIA 63W
006-A0154-02 GNS 480/CNX80
006-A0154-03 GNS 400W/500W
006-A0154-04 Other Garmin Series

Table 3
5) Make sure that the selected antenna and software version option matches the antenna and GPS software 

installed on the aircraft that will fl y the fl ight plan.  To change the selected antenna and software version 
option, click the down arrow next to the ‘Antenna’ fi eld.  A pull-down list appears listing the available antenna 
and software version confi guration options.  Table 4 describes the available antenna and software version 
confi guration options available in the “Antenna” fi eld pull-down list.

 
NOTE:  The installed antenna model may be listed in the applicable AFMS.

Antenna and Software 
Version Option as 

Displayed in “Selected 
Antenna” Pull-down List

Option Description

GPS SW >= 3.XX This option should be selected when the installed GPS software version is 3.XX or later and the 
installed antenna is one of the Garmin approved antennas that result in a fully compliant WAAS 
system capable of being operated without limitation.  See the installation manual for your Garmin 
system for the list of approved compliant antennas.

GPS SW >= 3.XX & GA56W This option should be selected when the installed GPS software version is 3.XX or later and the 
installed antenna is the Garmin GA56W.

GPS SW >= 3.XX & GA57 This option should be selected when the installed GPS software version is 3.XX or later and the 
installed antenna is the Garmin GA57.

A-33 (575-9/590-1104)
A-34 (575-93/590-1112)
GA35 (013-00235-00)
GA36 (013-00244-00)
GA37 (013-00245-00)
GA56A (011-01154-00)
GA56W(011-01111-00)
GA57 (011-01032-00)
CI2580-200
CI2580-410
CI2728-200
CI2728-410
CI428-200
CI428-410

One of these options should be selected when the installed GPS software version is less than 3.0 
and the installed antenna matches the antenna displayed in the ‘Selected Antenna’ pull-down list.

Most Conservative This option should be selected when the confi guration of the installed GPS SW version and/or 
antenna model are not known.

Table 4
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6) To change the departure date, click the down arrow next to the ‘Date (UTC)’ fi eld.  A calendar window appears.  
Click the left or right arrows to select a different month (if desired), then click the desired date.

7) To change the departure time, click the hours, minutes, or seconds fi elds next to the ‘Time (UTC)’ fi eld.  Click the 
up or down arrows (or type in desired time) to change the displayed time.

8) To change the planned route type, average ground speed, ground speed variation, maximum allowed outage, 
fl ight duration, Selective Availability conditions, or to deselect satellites, click the ‘Setup’ button.  A setup window 
is displayed (Figure 7).  Click the fi eld for the desired item, then enter the desired value.  Table 5 describes the 
Flight Setup Window options.

Flight Setup Window 
Options

Option Description

Route Type Oceanic -For Oceanic/Remote only operations
Enroute/Terminal - For all other operations

Maximum Allowed Outage 
(Time)

This fi eld defaults to 5 minutes when Oceanic is the selected route type.
This fi eld is set to default and ‘greyed out’ (not selectable) when Enroute/Terminal is the selected 
route type.

Ground Speed (Avg) Enter expected average ground speed for fl ight.
Ground Speed Variation The ground speed variation setting will vary with the selected route type, the default is 100 knots 

for Oceanic and 10 knots for Enroute/Terminal route types.  The program automatically runs 
multiple predictions for a range of ground speeds based on this setting.

Flight Duration This fi eld is calculated from the entered ground speed and route information; or the fl ight duration 
can be entered, and the program will calculate the average ground speed.

Departure Date and Time Enter date and time (in UTC format) of departure, this info can also be entered into the main 
screen of this program.

Selective Availability Simulates Selective Availability conditions when box is checked (normally left unchecked).
De-select Satellites Click on the De-select Satellites button to view the Selected Satellites window, see following 

instructions.
Table 5

 
NOTE:  The maximum allowed outage times for Oceanic fl ights vary according to the specifi c route.  The pilot 
must determine the proper allowed outage time to be used for the prediction, based upon the route that is being 
fl own.
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Figure 7  Flight Setup Window

9) To deselect satellites from the setup window, click ‘De-select Satellites’, then clear the box adjacent to any satellite 
that should not be used in the prediction (Figure 8).  WAAS satellites are not listed in the Satellite Selection 
Window as RAIM and FDE availability are not predicated on the availability of WAAS satellites.  However, WAAS 
satellites are required to conduct LPV and LNAV/VNAV approaches.  Always check for NOTAMs regarding LPV 
and LNAV/VNAV outages (in addition to using the Prediction Program) to determine the availability of LPV and 
LNAV/VNAV approaches at the destination.

Figure 8  Selected Satellites Window

 NOTE:  Satellites that are unavailable will be ‘greyed-out’ with no check marks.  Satellites with ‘Poor Health’ will 
default to unchecked status.
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Figure 9  Almanac Warning

 NOTE:  To ensure accuracy of results, the almanac data used for the RAIM and FDE predictions must be recent.  
If the information is out of date, the WFDE Prediction Program will automatically prompt the user to update the 
almanac data (Figure 9).  An internet connection is required to use this feature (see following instructions).

10) To calculate RAIM, FDE availability, and WAAS satellite availability; select the ‘Calculate’ button from the 
main WFDE Prediction Program window (Figure 6).  A ‘Calculation is complete’ message will appear when the 
prediction is complete (Figure 10).

Figure 10  Calculation Complete Screen

11) The GPS/FDE Availability Results screen (Figure 11) appears after clicking the OK button on the ‘Calculation is 
complete’ message screen.  The results can be viewed or printed (see Printing section of this document) for later 
reference.
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This Prediction 
is Based on the 

Displayed Estimated 
Arrival Time ±15 Min.

Displays the Leg 
of Route Where 
Outage Occurs 

Figure 11  GPS/FDE Availability Results Screen

Displays the Maximum 
FDE Outage Only 
(may be other FDE 

outages) 

Ground Speed for Outage 
May Differ from Entered 

Ground Speed, as Multiple 
Predictions are Calculated, 
Based on Entered Ground 

Speed Variation 

ETA Calculation 
Uses Ground Speed 
(Not Ground Speed 

Variation)

Displays the Results 
of the WAAS Satellite 
Availability Prediction Setup 

Information Box

GPS Prediction 
Results

RAIM Prediction 
Results

FDE Prediciton 
Results

Displays any 
Predicted GPS 

or RAIM Outage 
Information

Viewing the RAIM and FDE Prediction Results:

1) Select the View menu from the main WFDE Prediction Program window.  The results also appear automatically 
after clicking the OK button on the ‘Calculation is complete’ message screen.

2) Select Results.  A window will appear showing the calculation results (Figure 11).

3) To print the calculation results, see the Printing section of this document.
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4 INTERPRETING THE FDE PREDICTION RESULTS
The GPS/FDE Availability Results screen provides either a ‘GO’ or ‘STOP’ status for the GPS, RAIM, FDE, LNAV RAIM, and 

LNAV/VNAV & LPV minima availability.  A yellow fl ag is a possible result for an FDE prediction for a non-Oceanic prediction  
(see Figure 11).

A ‘GO’ status indicates that there are enough satellites available during the fl ight to meet the requirements of that category.
It is possible to have multiple FDE Availability outages during the fl ight and the status may still be a ‘GO’, as long as none of 
the outages exceeds the selected maximum allowable outage.

A ‘STOP’ status is the result of a predicted loss of satellite availability.  An FDE Availability or RAIM availability failure 
occurs when suffi cient satellites are not available for a period longer than the maximum allowable outage (as selected in the 
Flight Setup page and viewed in the Setup Information box on the GPS/FDE Availability Results screen) and will produce a 
‘STOP’ status.

A yellow fl ag indicates an FDE outage in a non-Oceanic (Enroute/Terminal) type prediction.  Because FDE availability is 
not required for Enroute/Terminal operations the yellow fl ag is only a caution to the pilot indicating that there may be an FDE 
outage when fl ying the fl ight plan.  The selected fl ight plan may be fl own despite the caution fl ag.  A ‘STOP’ status can appear 
in the FDE outage section only when an Oceanic prediction results in an FDE outage.

 Figure 12  Prediction Results Icons

More satellites are needed to provide FDE availability than are needed for RAIM.  More satellites are needed to provide 
RAIM availability than are needed for basic GPS availibilty.  A GPS Availability failure occurs when there is the loss of the 
ability to compute a position.  This is expected to be accompanied by a an FDE availability failure and a RAIM availability 
failure.  

• For Oceanic/Remote navigation predictions the displayed result should be ‘FDE is available for this route’.  In the 
event of a predicted outage, the fl ight should be delayed, canceled, or re-routed where FDE requirements can be 
met.

• For U.S. RNAV routes, SIDs, or STARs navigation predictions, the displayed result should be ‘RAIM is available for 
this route’.  In the event of a predicted outage, the fl ight should be delayed, canceled, or re-routed where RAIM 
requirements can be met.

• For LNAV approach at the arrival waypoint predictions, the displayed result should be ‘LNAV RAIM is available’.  
In the event that LNAV RAIM is not available, fl ight planning should include an approach that is not based on GPS 
navigation equipment.

• For LNAV/VNAV or LPV approach at the arrival waypoint predictions, the displayed result should be ‘LNAV/VNAV 
& LPV minima may be used for fl ight planning at the arrival waypoint for the estimated arrival time’.  In the event 
of an ‘LNAV/VNAV & LPV minima should not be used for fl ight planning at the arrival waypoint for the estimated 
arrival time’ result, fl ight planning should include an approach that has at least LNAV minima (if based on GPS 
navigation equipment) or an approach that is not based on GPS navigation equipment.

 
NOTE:  Since (due to unforeseen circumstances) actual departure times often differ from planned departure times, 
it is good practice to perform predictions for several possible departure times.
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Suggestions to change the result of a failed fl ight plan prediction:

1) Alter the departure date and time.

2) Alter the route of fl ight.

3) Verify any deselected satellites.  It is possible that some satellites unavailable for a previous prediction are now 
available.

4) Update the almanac, especially if it is more than three months old.

5) Use the correct antenna selection (if ‘Most Conservative’ was used).

6) For Oceanic/Remote operations, determine the actual maximum allowed outage and use for the prediction 
(instead of the 5 minute default setting which is generally shorter than the actual allowed outage time).
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5 UPDATING/CHANGING ALMANAC AND CONFIGURATION FILES

5.1 ALMANAC, GEO ALMANAC, AND CONFIGURATION FILES
To ensure that each is current, the Almanac, GEO Almanac, and Confi guration Files are automatically checked each time 

the program is started.  If the program fi nds any of these fi les to be out of date, it will automatically update the fi le via the 
internet.  A provision has been made to update these fi les manually, if needed.

Manually Updating the Almanac, GEO Almanac, and Confi guration Files:

1) From the main WFDE Prediction Program window, select the Help menu (Figure 13).

Figure 13  Help Pull-down Menu

2) Select Update Almanac, Update GEO Almanac, or Update Confi guration File.  The program automatically 
searches the internet and downloads the most recent data.

3) A pop-up window appears to confi rm that the data has been downloaded.  Click the OK button to return to the 
WFDE Prediction Program.

4) The fi le has been updated.

5.2 CHANGING THE CONFIGURATION FILE
The WFDE Prediction Program may be used with several different Garmin software programs.  Each program uses a 

specifi c confi guration fi le to run the WFDE Prediction Program.  If the user has multiple Garmin programs loaded, the user 
must verify that the confi guration fi le currently in use is correct for the Garmin product that will be used to navigate the fl ight 
plan.  Generally speaking, most users will not need to change the confi guration fi le, although a provision has been made to 
update these fi les manually, if needed.

Changing the WFDE Confi guration File:

1) From the main WFDE Prediction Program window, select the Help menu (Figure 13).

2) Select ‘Change WFDE Confi guration File’.

3) A pop-up window appears.  Click the OK button to allow the program to download new confi guration fi les via the 
internet.  When the confi guration fi les have been downloaded, a ‘Confi guration Select’ pop-up window appears.

4) Click the down arrow to view the pull-down list of available confi guration fi les (Figure 14).  Select the fi le 
corresponding to the Garmin product that will be used to navigate the fl ight plan.

 NOTE:  The  ‘Other Garmin series (006-D0740-04.ini)’ listing on the ‘Confi guration’ pulldown menu (Figure 14) 
should be selected when using a system with a TSO-C146A compliant WAAS antenna and software (see Section 
1.2).
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Figure 14  Confi guration Select Window

5) Click the correct fi le name on the pull-down list, then click the OK button.

6) The confi guration has been changed.  See Figure 6 and Table 3 to verify the correct part number appears on the 
WFDE Prediction Program window.
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6 PRINTING

6.1 PRINTING THE PREDICTION RESULTS
Use of the ‘Print’ selection on the ‘File’ menu (in the upper left-hand corner) is not recommended, as the complete results 

of the prediction are not included on the printout.  If a printout is desired, use the following steps.

Printing the Prediction Results:

1) From the GPS/FDE Availability Results screen (Figure 15), press ALT+PRINT SCREEN to make a copy of the image.

Figure 15  Calculation Complete Screen

2) Using another program (such as MS Word®), open the fi le you want to paste the image into and use the ‘Paste’ 
command to paste the image into the fi le.

3) Print the fi le from the “other” program.

4) Repeat the preceding steps (if desired) from the WFDE Prediction Program screen (Figure 6) to record the 
Departure Time.
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